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Edit Menu

This menu is used to cut, copy, and paste the objects on a particular card, parts of the back-
ground, or even entire cards,

Undo: This is used whenever you change your mind about certain editing actions. For ex-
ample, if you cut a button from a card, and then change your mind, you can choose Undo, and
the button will be put back as it was before the cut. If you paste a graphic onto the wrong card,
choosing Undo takes the graphic back off. Undo only reverses the very last action, and not all
actions can be undone.

Cut: An object (graphic, text or button) is cut by selecting the object with the edit tool (the
pointer - see the Tools menu), and then choosing Cut from the Edit menu. Once selected, you
can also press Apple-X on the keyboard to do a Cut. The Cut function removes the object from
the card, and places it on the elipboard. The clipboard is a term used to describe a lemporary
memory buffer where things are held while you decide what to do with them. The clipboard is
used with the Cut, Copy, and Paste commands to move objects from one card o another,

Once Cut, the object remains on the clipboard until you either quit HyperStudio, or until Cut
or Copy is chosen again from the menu.

In addition to objects, you can also cut portions of the background for pasting to another
location. Use the lasso and selector tools (Tools menu) 1o select the area to be cut, copied, or
cleared (erased).

Copy: Copy is identical to Cut, except that the original object is left in place, and a copy of
the object is placed on the clipboard. Pressing Apple-C is equivalent to choosing Copy from
the menu.

Backgrounds can be copied from one card to another, and this is the preferred way of using the
same on two different cards in those cases where the second card is not created
directly from the first.

Portions of the background can also be copied using the lasso and selector toals in the Tools
menu.

Paste: Choosing Paste from the Edit menu places a copy of the object on the clipboard onto
the current card. Once pasted, you can use the mouse to position the object, or portion of the
background, in the desired position. Clicking the mouse anywhere outside the pasted object
"drops” the item in the current position. Apple-V is the keyboard equivalent of the Pasie
command. When a card is pasted, it is always placed at the end of the current stack.
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Clear: This is used to delete an object without copying it to the clipboard. To delete an object,
simply click on it once with the edit wol (pointer - Tools menu). When the object is selected,
choose Clear from the Edit menu, or press the Clear (or Delete) key.

New Card: This is used each time you want to begin a new card in your stack. Each time New
Cardisselm‘led,mcbackgmundofmccm'mtca:ﬂisuﬂfmﬂnnewcnrd.ﬁnyobjectson
the current card are not copied.

Delete Card: This is used to remove a card from the stack. Note that this must be done with
some care, particularly in those cases where buttons on other cards in the stack are linked to the
card you are about 1o delete. Because this would leave those connections on other cards with
no destination, HyperStudio warns you if the card you are about to delete is pointed to by any
other cards. At that point, you'll have the choice of also deleting the buttons on other cards that
point to the card about 1o be deleted, or leaving them in place. If you leave them, and you
delete the card anyway, HyperStudio will mark those buttons as unaresolved, that is, they are
buttons that no longer have a destination.

Any visible button that is unresolved is indicated by being shown in red on a given card. This
is 10 make recognizing unresolved buttons easier. You can then go through your stack, and
easily recognize cards with unresolved buttons, editing the tuttons as necessary for the proper
operation of the stack.

Cut Card: This cuts the entire card to the clipboard, with the expectation that you will paste
the card into another stack, or perhaps at the end of the current stack. The card will remain on
the clipboard until you choose cut or copy again from the menu,

Lichlear,ifyoucmacardlhatispuinmdwbymhercmﬂs.anddunmpamci:backinmihn
stack, any unresolved buttons will thereafter be displayed in red.

Copy Card: This is identical to the Cut Card function, except that the selected card is not

deleted from the stack. The two immediate consequences of this are that, first, there is no need

to worry about unresolved butions on other cards, since the original card remains. Second, the

cczfdim cafe:rlf pasted, is not pointed to by any existing butions, since it will be given a new
number.

Erase Background: This erases the current background to one of the 16 colors on the
HyperStudio palette. See Set Background Colors, in the Options menu.
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Move Menu

This menu makes it easy to move around in a HyperStudio stack. The commands are as
follows:

Back: Selecting this takes you back, one card at a time, through the last 16 cards viewed.
This makes it easy to return to a card you viewed recently. This is different than the Previous
Card choice below. Back goes back through the cards in the order you viewed them; Previous
goes 1o the card that is physically in front of the current card.

Home: The Home Card is a significant point in the HyperStudio system. It is a "home base”
from which different stacks, and even applications, can be used. When you quit a given stack
or application, HyperStudio will always return to the Home Card.

Many stacks also have Home Card icons on various cards. Clicking on the Home Card icon
also returns you to the Home Card.

First Card: Choosing this takes you to the first card in the current stack.

Previous Card: This takes you to the previous card in the current stack. If you are already on
the first card in the stack, choosing this takes you to the last card in the stack. This is called a
"wrap-around” effect. Note that both Previous and Next Card functions go to the card specified
in terms of its position in the stack, not the order the user viewed the cards.

Next Card: This takes you to the next card in the current stack. If you are already on the last
card in the stack, choosing this takes you to the first card in the stack.

Last Card: Choosing this takes you to the last card in the stack.

Find...: Choosing this opens a window in which you can type a word or phrase. When you
press Return, HyperStudio will search through all the text items in that stack for the search
word(s). Note that HyperStudio searches from the current card forward. If you want to search
the stack from the beginning, be sure to remember to move 1o the first card before beginning
your search.

When you do your search, you will have the option of searching just the changeable or fixed
text fields on each card. You can also choose 1o search both. The difference in these types of
fields is described in the section on the text item tool.

Once the search has begun, you can search to the next occurence by pressing Shift-Apple-F.
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Tools Menu

The tools menu is an icon-based menu with two major groups of tools. The upper group of
icons represent major editing tools for screen itlems such as the text, graphics, and button
objects. The remaining tools are all paint tools, used when editing the graphics that make up
the curremt background.

Browse (hand): While editing a stack, you may want to click on a bution to verify its action,
or 1o move to another card. Selecting this tool gives a hand icon that is used 1o activate a
button. This is the default tool when HyperSwmdio is started up, and the Home Stack is loaded.

Button: This is used to highlight invisible buttons for editing, and to move or resize both
visible and invisible buttons. When you choose the button tool, all invisible buttons will be
shown surrounded by rectangles. You can then use the button tool to click on a particular
button to select it for dragging to a new position, or a cut, copy, or delete action. Selected
buttons can be resized by dragging the comers of the bution.

When a button is selected, you can choose Item Info in the Objects menu to get a description of
the button, or to edit the button name and appearance if you wish.

Edit Tool (pointer): This tool is a combination of all the specific edit wols (button, graphic
and text) used to select items for editing. Once selected, the item can be moved, edited, cut,
copied or deleted. Once a given item is selected, you can also use the Item Info function in the
Object menu for information about that object.

In general, the editing rules are as follows:

To Re-Position an Ohject: First, click on the item to select it. Then, put the cursor over
an item, hold down the mouse button and drag the mouse to
move the object to the new position. For buttons and text
objects, the object can be resized by dragging the comers of
the rectangle of the object. Clicking anywhere outside the
window places the object in its current position, and dese-
lects the object.

To Edit an Object: When an object has been selected by clicking once on it, it

can then be cut, copied, or deleted with the appropriate

option in the Edit menu.

If you want to edit particular attributes of the object, such as
the name and appearance of a particular button, etc., you
can select it with the edit tool, and then choose Item Info in
the Objects menu, and make related choices from there,
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Picture Tool: Choosing this icon will activate the tool that will let you edit all the graphic
objects on the current card. You can use the picture tool to click once on a particular graphic
item to select it for resizing, dragging to a new position, or a cut, copy, or delete action.

If you select the Item Info dialog box for the graphic (see the description of Item Info in the
Objects menu), you can change the border type using the same dialog boxes and controls as
were used when the graphic item was first added to the card.

Sound Tool: This icon shows a speaker, and is used to highlight all those invisible buttons on
the current card that have a sound attached to them.

After all the invisible buttons with sounds have been highlighted, clicking once on any of them
selects that button for dragging, or cut, copy or delete actions. Choosing the Item Info dialog
box for a bution (see the description of Item Info in the Objects menu), lets you can view and
edit the button name and appearance.

Text Tool: Choose this to display all text items on the current card. Use the Text ool to click
on a particular item to select it for resizing, dragging, or a cut, copy, or delete action.

If you want to edit the text in a text item, use the browse tool, and click on the item. When
using the Text tool, you can choose Item Info in the Objects menu if you want to make
changes o the overall appearance of the text item, or change whether it is a fixed or
changeable text block. Note that disk-based (extended) text objects are always read-only.

Paint Tools

The remaining tools in the Tools menu are used for editing the background graphic image.
Although the images in graphic objects cannot be edited directly, you can load any 640-mode
Super Hi-Res screen as a background, edit it with the paint tools, and then save the screen.
These saved images can then be used as either a background or a graphic item.

The paint tools are as follows:

Selector Tool: This is used to select a rectangular area on the screen to be cut, copied, or
moved by dragging. When the selector tool is active, the cursor changes to a cross-hair. An
area is selected by pressing the mouse button, and then dragging the mouse with the button
held down. As you move the mouse, a rectangle will indicate the area to be selected. When
you release the mouse bution, a blinking dotted line shows the selecied area. You can then
choose Cut or Copy from the Edit menu. Cut and Copy each put the graphic image on the
clipboard, after which it can be pasted on the current card, or any other card in the stack. If Cut
is used, the selected area is replaced by whatever color is under the upper-left comer of the
rectangle.
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If you want to move the selected area, simply move the mouse inside the rectangle. The cursor
will change to an arrow. Then hold down the mouse button while you drag the mouse, When
you release the mouse button, the image will be placed at that location. The area underneath
lhcglm:vedmmgleisreplacedbywhamercahrisunderlhc upper-left corner of the rec-
Lan

If you change your mind about the area you have selected, clicking the mouse once outside the
selected area removes the selection box. You can also click inside the selected area to deselect
it, but you must be careful not o move the mouse as you click the button, otherwise the region
may be moved as well.

Lasso: This is similar 1o the Selector tool, but is used to outline an image on a solid-colored
background. After selecting the lasso tool, you draw a free-hand line around the object to be
selected. When you release the mouse button, the color under the cursor when you started the
ln.&misuwdasthcbackgruundcolm,andmlypnmufmeh'uagcdiffermt&nmﬂmback-
ground are selected with an outline.

Once selected, the item can be Cut, Copied, or moved, just as you would with the Selector tool.

Pencil: The pencil is a fine-line drawing (ool that draws a free-hand line in whatever the
currently selected color is. The current color is chosen from the Colors menu, With this and the
other drawing tools, if you change your mind after drawing a line, just choose Undo in the Edit
menu. You can only undo the very last drawing action.

Paintbrush: This tool is like the pencil, but it can draw a variety of line widths. The brush can
also have different shapes, which can be used to produce different effects.

The brush shape is chosen with the Brush Shapes item in the Options menu. The current brush
color is set using the Colors menu.

Eraser: This is a handy way (0 erase an area of the screen. It is really equivalent to drawing
with a rectangular brush using the color currently set by the Set Background Color option in
the Options menu,

Linel'rnul: This is used to draw straight lines in the current color. Lines are drawn by just
pressing the mouse button at the point where you want the line to begin, dragging the mouse to
draw the line, and then releasing the mouse button where you want the line to end. Notice that
while the mouse button is down, you can reposition the end of the line anywhere you want
until the mouse button is released.

The width of the lines being drawn can be changed using the Line Size function in the Options
menu.

Page 35




Reference HyperStudio

Spraypaint Brush: This tool paints a scattered pattern of dots in the current color. By moving
the pattern over an existing image, you can create variations in shades, or just add interest to
the overall pattern.

Rectangle: This draws a rectangle in the current color, with a border of the current line width.
Press the mouse button to start drawing, and release the button when the rectangle is the
desired size.

You can also draw a solid rectangle by choosing the Draw Filled item in the Options menu.
When this is active, there is a checkmark next to the menu item, and the rectangle tool will
draw solid rectangles in the current color.

Rounded Rectangle: This is identical to the rectangle tool, except that the rectangle drawn
has rounded corners. As with the rectangle tool, the shape is drawn using the current color and
line width. If Draw Filled is active, a solid shape is drawn.

Fill: The tool icon for this represents a paint can pouring paint. This is used to fill an enclosed
region with a solid color. The active part of the fill-cursor is the very tip of the black area on
the cursor that represents the paint pouring out. The fill also uses the current color. The main
thing to be careful of when using the fill tool is to make sure that there are no "leaks” in the
area you are about to fill. However, in the event the fill does cover a larger area than you
intended, you can choose Undo to restore the original image.

Oval: This is similar to the rectangle tool, except that it draws an oval shape in the current
color and line width. When you first press the mouse button, that point represents the upper
left comer of an imaginary rectangle that contains the oval being drawn. The point at which
you release the mouse button represents the lower right comer. If you want a solid oval, use
the Draw Filled item in the Options menu.

Freehand Shape: This tool draws a closed free-hand shape using the current color and line
width. When you release the mouse button, a final line will be drawn from the end point to the
starting point, if you have not already closed the curve. If you want a solid shape, use the Draw
Filled item in the Options menu.

Text: This is used to add text to the background image. This is not the same as adding a rext
item! A text item is an independent object that can be moved and edited at any time. The
painting text wol, on the other hand, simply prints the text you type on the screen, at which
point it becomes part of the background.

When you choose the text tool, the cursor changes to an I-shaped cursor. To type lext, position
the cursor where you want 1o start typing at, and click the mouse once. The positioning cursor
will then disappear, and you'll see an insertion-cursor at the point where you are typing.
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The color of the text is controlled by the choice set in the Set Text Color function in the
Options menu. This will generally look best if the color is simply black or white, but will also
depend on the background color as well. While you are typing, you can use the Text Style item
in the Options menu to change the type style of the text that is being entered. However, once
you click the mouse in a new location, or choose another paint twol, the text will be merged
into the background image, and can no longer be changed. Note: When typing text on a
background that is neither black nor white, larger text sizes (see the Text Styles... choice in the
Options menu) will produce better results.

Magnifying Glass: This is a special mode for magnifying the image within a given area on
the background, and allows you to edit the screen dots pixel-by-pixel. This is also sometimes
called either a "fatbits” or "zoom" mode.

When you first select this item, a rectangle will appear on the screen that represents the area to
be magnified. Use the mouse to position the rectangle over the area you want to examine, and
then click the mouse button. You will then see a magnified image, with a normal view of the
same ared in the upper left comer of the screen. The paint tool at that point is the pencil, and
you can re-draw any point you wish in the current color.

You can use the Colors menu to change colors. You can also "pick up” a color from the current
magnified view by holding down the Apple key, and clicking on the new color. While you are
in the magnified mode, if you want to scroll the screen, you can hold down the Option key.
The cursor will change to a hand, and dragging the mouse will move the magnified image in
the same direction as the mouse movement.

Using any other paint tool, or clicking the mouse in the normal view window will exit the
magnified mode, and return you to a normal view.

If you have used the magnified mode once already, then selecting it again will automatically
start the selecting rectangle at the old position, although you can still move it to a new position
with the mouse if you wish.

Polygon: This functions lets you draw a closed polygon shape, using the current color and line
width. When you release the mouse button, it will complete the shape by drawing a final line
from the end point to the starting point, if necessary. If you want a solid shape, use the Draw
Filled item in the Options menu.,
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Objects Menu

This menu is used to add and edit objects on a given card. Ii also provides information about
the memory used by the current background, card, stack, and a given object.

Item Info: To use this, first select an object on the current card, using either a specific tool
(like the buttons, text, or graphic tool), or the edit tool (the pointer). Then choose Item Info
from the Objects menu. Depending on the actual item you have selected, the information
reported will be:

Button Info: This reports the name of the button. Even invisible butions can be given names.
Whatever text is entered on the edit-line when the button is created is used for the button
name. Names are not only used for visible buttons, but are written out to the disk as part of the
HS.Test.Results file for both visible and invisible butions, if the given stack is a test function
stack. The dialog box also provides an easy way of changing the button style.

There is also an entry for "Button ID", The value for Button ID is a number used by
HyperStudio to keep track of all the buttons in a given stack. It is provided for reference only,
and it is unlikely that you will ever need to use iL

Buttons actions cannot be directly edited (since redefining the actions would take just as long
as creating a new one); to change a button action, use the Button tool to select and delete a
button. Then create a new button to do what you want.

Text Info: This dialog box tells you whether a text field is scrollable or not, whether a scroll
bar will be drawn for the text item, whether the text is read-only (not changeable by the user),
and whether a frame will be drawn around the text item. Which features you use will depend
on the nature of a given text item. For example, if you were creating single-line entries, such
as an address book, eic., you would want each field 1o be non-scrolling, without scroll bars or a
frame.

Graphics Info: This reports whether a given graphic item is embedded or disk-based, how
much memory it uses, and lets you change the border size.

Card Info: When this is chosen, a dialog box appears that identifies the position of the
current card in the siack, how many buttons, sounds and graphics are on that card, and how
much memory is used by that card. The memory-required value is to the nearest 1K, and may
read "0" if the card uses less than 1000 bytes of memory.

Background Info: This displays a dialog box that shows how much memory within the stack
the current background uses, and how many cards in the stack use that background. Note that
backgrounds are always contained within the stack itself. When the background is stored in the
siack, it is compressed to minimize the amount of memory required.
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Also, when a new stack is created, the background memory use will read 32K until the next
card is created, or the stack is saved. Once compressed, Background Info will display the
correct value,

Stack Info: This displays a dialog box that provides information about the entire stack.
Information shown includes the size of the stack itself in memory, how many backgrounds are
used by the stack, how many cards are in the stack, and other useful facts.

Bring Forward: Use this when two objects overlap, and you want the selected item to be on
"top". Not all objects can be arbitrarily stacked. For example, text items are always "in front"
of graphic items. Items of the same type can be adjusted relative to one another.

Send Behind: Use this when two objects overlap, and you want the selected item to be on
"the bottom".

Adding Objects to a Card

Add a Button: Choosing this menu item tells HyperStudio that you want to add a new button
to the current card. When chosen, you'll be shown a dialog box that lets you choose from
among different button designs. At the bottom of the dialog box is a line with a blinking
cursor. This is where you can enter any text that you want displayed within a visible button
when it is displayed on the screen. If you don't want any text on the button, just leave this field
blank. After you have chosen the button style you want, click on OK.

Thcﬁrs:limeLhmynuaddabumn.HyperSnﬂiowi[lrerrﬂndymtoposiﬁmthcbumn.and
then click outside the button when done. Click on "Continue” after reading this dialog box.
Youcanuszlhcmousemdrsgmcblmmlowhﬂmvcrlocaﬁnnmﬂncardywwish.m

you have placed the button where you want it, click anywhere outside of the button to "drop" it
at the current position.

If you have selected the "Invisible" button, you'll get a dotied line rectangle indicating the "hot
area” for that button. Use the mouse to position the rectangle over whatever portion of the
screen you want to act as a button. You might, for example, put a rectangle over a picture of an
armow o use as a button, When positioned, click anywhere outside of the rectangle. You can
resize the button area by dragging any of the comers.

Button Actions: When you have positioned either the standard or invisible buttons, the next
step is 1o specify what action you want taken when the button is activated. A dialog box will
appear that has two major groups:

Connect To... This allows you to specify where to branch to when the button is activated. The
choices are:
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* Another Card: Choosing this will connect the button 1o another card in the stack. When
you select this, you'll be temporarily remined to the current card, and a window will be
displayed that says "Move to the card that is the target of this button. Click OK when the
proper card is displayed. You can now use any of the usual HyperStudio Move menu
commands, (or even existing buttons on a card), 1o move to another card in the stack. When
you find the card you want the button to connect to, just click the OK button. You cannot
connect Lo a card in another stack. Use Connect to Another Stack for that

+ Next Card: This will automatically link the button on the current card to the next card in the
stack. Note that this connection is specifically to the next card. That is, if at some point in the
future you delete the target of this button, this button will not go to the new "next card”, but
will be unresolved since its actual target card is gone.

+ Previous Card: This is similar to Next Card, but instead creates a link to whatever card is
currently in front of the current card.

* Another Stack: You can also connect a button to an entirely different stack. When you
choose this item, you'll be presented with the File Interface, with which you can specify the
stack that you want to move to when that button is activated. There is no particular limitation
on the destination stack. That is, you can specify stacks in other directories, or even on other
disks. If the required disk or directory cannot be found when the button is pressed, the user
will be prompted to locate the required files.

Note: HyperStudio always looks first in the current directory for a given stack, graphic, sound,
application, or any disk-based item. Thus, you cannot connect to another stack in a different
directory if a stack with the same name exists in the same directory as the active stack, Also, if
you have a stack or application in one folder, and then move it, the connection will no longer
work because the target has moved. One way around this is to put the target stack or
application in the same folder as the branching stack. Then the connection will always work,
no matter where the total group of stacks and applications is located.

* Connect to Application: A button can also start an application. For example, you could
have a button start up AppleWorks, or any other application. When that application quits, it
will automatically return to HyperStudio. The application to be run is selected with the File
Interface. Afier you have selected the application, a dialog box will appear that asks whether
you want to return to the current card, the first card in the current stack, or the Home Card
when the application finishes. You can also elect 10 not retumn 1o HyperStudio at all, but rather
whalever program selector was used to launch HyperStudio, for example, the Finder.

Transitions: In each of the Connect To... actions, you also have the choice of a visual effect,
called a transition. A transition is a special screen effect that makes the movement from one
card to another more visually interesting. After choosing one of the above items, you also can
choose one of 16 transition effects. The fastest transition is the default one, labeled, coinciden-
tally enough, "Fastest”. Other effective transitions are the fade-to-white and fade-to-black. In
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gddiu'm_l, there are what are called screen wipes, which change one screen into another with an
interesting effect. The best way to understand what these do is to experiment with them.

Actions... When a bution is pressed, there are actions other than (or in addition to) branching
lo another card, stack or application, that are possible. These choices are also indicated:

* Play Sound: You can have a sound play when a button is pressed. If you choose this action,
ym;;;lll be asked whether you want to use an existing sound file on disk, or use the "live
record” mode.

Adding a Sound from Disk: If you choose to use an existing sound file, then you'll be shown
the usual File Interface, from where you can choose a sound file.

Once you have selected the sound file to use, HyperStudio brings up a screen with a picture of
]3 ls;]m recorder. There are also controls for playing the sound, and setting the playback volume
evel,

At this point you would click on the Play button to verify that this is the sound you want (o
add, and that the volume is satisfactory for your application. In the Preferences dialog box
(Apple menu), the user can set their own volume level, but this will help set the volume of the
current sound sample in relation to the others.

Once the sound is played the way you want it, simply click on the Done button, If you have the
Preferences set to Advanced User, you'll then be asked about the data access method. Other-
wise, you'll just go back to the normal HyperStudio program operation.

Note: If you have sound files from other systems, you should first load them in the Sound
Shnpm:grmn,andﬂmmvcﬂnmbackmdjskmﬂ]eSmndShnpfmnaLﬂﬂxisbucause
most sound files from other companies do not contain any information about the playback rate
and volume setting, and more importantly don't have a "signature” that clearly identifies what
system they were created on. Without these values, it is unlikely the file can be played directly
by HyperStudio with the desired volume and playback rates. The solution is to first load the
sound file in Sound Shop, and 10 then save the file back to the disk. Sound Shop uses an "offi-
cial" Apple filetype, and includes the information about the playback rate, volume, etc. in the
Eclmnd file. These values, in turn, are automatically used by HyperStudio when using the sound
e in a stack.

* Play a Video: A button-press can also trigger the appearance of a video sequence generated
by a Pioneer 2200, 4200 or 8000 LaserDisc player atached to the Apple 1IGS. This does not
control VCR players, or other video sources (see the Live Video demo in the Xcmds folder if
you have an Apple I Video Overlay Card (VOC), and want 1o experiment with video in
HyperStudio).
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The Pioneer 4200 is attached to the Apple IIGS modem port, using a simple modem cable with
the proper connectors on each end. You must make sure your "Slots” setting in the Control
Panel has Slot 2 set to "Modem", and the "Modem" setting is set to 4800 baud.

When you select this, you'll first be asked if you want 1o show video in the screen border. This
is only available with the VOC, and is used if you want the video image to completely fill the
monitor, Afier making your selection, a LaserDisc Control box will appear on the screen. If
you have the VOC, a rectangle will also appear in the center of the screen. This represents the
area where the video image from your video will be displayed on the screen.

If you have the VOC, HyperSwdio will then display a rectangle, with handles, that can be re-
sized and positioned as you wish. This rectangle determines exactly what portion of your
video image will be displayed on the card. Changing the size of the rectangle does not shrink
the entire video image into the new rectangle. Rather, this is just a "window" onto the video
image produced by the videodisc player.

If you don't have the VOC, you can still use HyperStudio to bring up a given image or se-
quence in connection with any particular card. If there isn't a VOC in the computer, HyperStu-
dio will display the remote-control box on the screen, but will not put a rectangle on the
screen. In this case you would use a second TV or monitor Lo display the output from the

A video sequence is defined by specifying the beginning and end frame numbers of the video
10 be shown when the current card is displayed. The radio button starts on the "Begin" setting.
Click on the Play or Step buttons to find the beginning of the sequence you want to use. If the
disk is Playing, clicking on Step or Pause will stop the disk on that frame, and update the
frame number register with the current frame number. You can also press the Clear key on the
Apple keyboard, and enter a new frame number. The player will then jump to that frame. To
set the ending frame, click on the "End" radio button, and then click on Play 1o let a few
seconds of video roll by. If you want to show only a single frame, just set the End frame # the
same as the beginning. Frame numbers can be entered manually, and you can use the TAB
key to switch between the Begin and End frame boxes. When you enter a number in a box, the
radio button will automatically move to that box.

You can test your video by pressing the Test button. When you get the sequence you want,
just click on the Keep button.

That's it! Now, whenever this button is pressed, the video sequence will be shown. A video
sequence is only played once when the button is pressed. If you want a video sequence 10
repeal at regular intervals, or after a set time period, see the discussion on setting the time
period for an "Auto-activate” button, which is described later in this manual.

A video sequence can also be attached to a given card, so that the video sequence is shown as
soon as the user moves o that card. See the Add a Video seciion later in this manual.
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Other LaserDisc Control Features:

While you are defining the video sequence, there are a number of features i LaserDi
Control box that you should be aware of: ’ i N

Play: You can play either forward or backward by clicking on the arrow buttons to either sid
of the word "Play". If the End frame number is less than the beginning frame number when ’
you finally choose "Keep”, then the sequence will be played backward,

!(Eﬂillnd: ;3? cliac!icing oul: the button normally marked "Stereo”, you can switch the sound off
silent”), or select either the left or right andio channels. Sound is not available at pla
speeds other than Normal. payhack

Playback Speed: By clicking on the buttons to the left and right of the word "Norm"

change the speed at which the video is playing, Faster speeds available include ¢ and an.
Slower speeds include half-speed down to 1/16 speed, and two special "slide show" modes of
ul?eﬁmwwylazsecmﬂs. Hemdmujwhmﬂwﬂdwwqmmeismhylhem
will be whatever the speed value is when you finally click on "Keep". Thus, you ¢an can use
_lhe fasEc.r speed settings when finding the frames you want. Just remember 1o set it back to
lh?'iﬂ:;laﬂ?:g:m clicking on "Keep” - that is, unless you deliberately want a different speed in

Chapter Mode: If you click on the buttons marked "Fm", 10 the right of the frame number
indicators, the button will change 1o "Ch" (for "Chapter"), and the number display will show
whmchapterdut!framqnmnbeﬁsfmnm in. If you click on the frame box while in the chapter
mode, the LaserDisc will seek to the beginning of that chapter,

Disphi:ﬁ If you s:fc li-'lnc the full-screen mode, and have an active show-through area in the
upper-left comer screen, then the current frame number will be displayed. Clickin
the Display button twggles the display between on and off. e e

Step: Clicking on either side of the word "Step" will move one frame forward or backward.

Start/Reject: If the LaserDisc player is not fully started when i i

: you bring up the LaserDisc
Control, then |.hc button in the upper-left comer of the box will read "Start”. Click on this 10
start the player if the other controls in the box are net yet visible. Once the player starts, this
button changes 1o "Reject”, and will eject the disk if pressed.

Creating a Full-Screen Video

In normal use, the video image (with the Apple II Video Overla i

m y Card) will only show through
lhg. region defined by the video rectangle used when Adding a Card Video. Hm{'eva. the *
Video Overlay Card works by defining a color as the "key-color”, or "show-through color” on
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the screen. Before a video is added o a card, the key color is purple. The purple hue on the
screen changes 10 a pure blue once a video object has been added to a card.

There are two degrees of "full-screen” on the Apple IIGS. The first is the active screen area,
excluding the border area. The larger full-screen includes the monitor border area as well.
You can design a card o use either method.

If you want to create a video image that fills the entire background of a card, you can do this
by painting the entire card background with the proper show-through color. The color o
choose for filling the background will either be purple or blue, depending on whether a video
has already been added to a given card, but its position in the color table will always be the
same: color #6. That is, in the "Colors" menu, choose the second color from the left in the
second row from the top. If you are using the "Set Background Color” menu option (Options
menu), use the 6th color choice from the left.

When your video image is displayed, the video will be seen across the entire screen, regardless
of the actual video rectangle. In most cases, you'll find it easier w just make the video rec-
tangle as small as you can, and then move the video rectangle to some out-of-the-way spot on
the screen (but still over an active video show-through area).

If you want the video image to fill the screen border area as well, then click on "Yes" when
first adding a video, when you see the dialog box asking if you want to show the video in the
screen border area. The only real difference between these is that HyperSwudio changes the GS
border color to the "key-color”. This will allow the video image to go to the absolute edge of
the monitor screen.

The advaniage of using the background graphic itself (as opposed to the video rectangle) for
the video show-through area is that it is easy to re-paint a rectangle or other area if you want to
change the image area. In addition, you can use the Add clip-art, or other paint tools, to
overlay labels, arrows, or icon-buttons onto your video image. You should also try drawing
some rectangles, with "draw filled" checked in the Options menu, in various colors. You'll
notice that colors range from completely transparent (blue) to completely opaque (black,
white, grey, and shades of red), and others are in-between. This can create very neat effects
that show a dimmed image of a larger video image, with a certain part "highlighted” by being
100% transparent, and thus brightest.

The real key here is to just experiment. You can't hurt anything, and you're likely to discover
many useful techniques in the process. Also remember to experiment with using the paint tools
to create small windows with video showing through. We've found that although the video
rectangle is the easiet to explain and use for beginning users, in the long run, using the paint
tools will give the most flexible results.
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» Trigger Xcmds: This is an advanced feature of HyperStudio that is available to those people
who want 1o extend the functions of HyperStudio beyond the built-in feamres.

When you choose this option, a dialog box appears that prompts you for the text which will be
passed to an Xemd. What you enter, if anything, depends entirely on the Xemd being called.

Here's an overview of the Xcmd system:

When any given stack is opened in HyperStudio, the same directory that the stack was in is
checked for a file named HS.Xcmd. If found, that file is also loaded into memory. Then,
whenever the user clicks on a button that has been given an Xcmd function, HyperStudio
passes control to the file (HS.Xcmd) that was loaded, and passes it the text that was entered for
that button as well.

Examples of Xcmds are included on the HS.Demo and HS.Art disks. For example, although
HyperStudio has a menu choice for finding text in a stack, suppose you wanted (o create a
button which, when pressed, would jump 1o a card that had a pre-defined phrase of text on it.
The demo "Find.Demo" in the Xcmds folder on the HS.Demo disk (click on Find Demo in the
Home Card) shows how this might work. You could put this function in your own stacks by
moving the file HS.Xcmd from the Find folder on the HS.Demo disk to whatever folder had
your own stack in it. To define the Find Xcmd button in your own stack, you would then just
creale a new button, and choose Trigger Xcmd as the Action. You would then enter the text to
be searched for whenever that bution was pressed.

Another example on the HS.Art disk is an Xcmd for displaying a single full-screen 320-mode
picture in a stack. See the demo Test.320.Stack in the Test.320 folder on the HS.Art disk. In
this Xcmd, you simply enter a number when creating the button that tells HyperStudio how
many 10ths of a second to pause between each picture in a slide show. Entering a value of 10
would pause 1 second. To show a single 320-mode graphic, you simply put the HS.Xcmd file
from the Test.320 folder in the same folder as your stack, and then put a single 320 mode
picture in the directory with it. See the Test.320.Stack for more information.

The HS.Demo disk has assembly language source files for those interested in pursuing this
area further. Xcmds can also be writlen in other languages like Pascal, so long as the language
can creale stand-along OMF load modules (such as NDAs) on the Apple IIGS.

* Animate: This is actually somewhat similar to Adding a Graphic (see later). The difference
here is that you can attach the appearance of a graphic, and its animation, to a button-press.
Choosing the Animate action will take you through a sequence which is the same as though
you were adding a graphic,

Some (but not all) graphic programs offer animation functions. Paintworks Gold and
BeaglePaint support an animation format where many different frames can be combined into
one file o make up an animated image. The animation is created with a series of Super Hi-Res
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pictures, with filenames that are numbered. An animation sequence for a bouncing ball might
consist of the files BALLO1, BALLD2, BALLO3, eic.

‘When you choose Animate from the actions menu, you go through a process similar to adding
a graphic object. The choice of disk files will include not only the usual graphics, but also
animation files (type $C2) from PaintWorks Gold. If you choose a filename that ends with a
number, the disk is checked for additional files that continue the sequence. For example, if you
used the file BIRD1 as a graphic item, HyperStudio would automatically look for the files
BIRD2, BIRD?3, eic., until it ran out of files.

After choosing a file, a window will open that shows the first frame of the animation. Only the
part of the graphic visible in the window you create is displayed during the animation
sequence, and if anything in your animation moves outside this area, then it will nol be visible.
Clicking outside the rectangle drops the graphic in place, and you'll be returned 1o the button
action dialog box. If the graphic you have specified is part of a numbered series of frames,
HyperStudio will generate the animation before retumning to the Actions dialog box.

In the Actions dialog box, you should enter a Rate and Repeat Count. The Rate is counted in
60ths of a second, and controls how fast the animation runs. Thus, a value of 30 would be two
frames per second. The Repeat value controls how many times the sequence repeats itself,

‘When an animation plays, it may clear an area slightly larger than the actual rectangle you
defined. This has 10 do with limitations in the method used by PaintWorks Gold.

Test Functions

On any card, buttons can be either "No test function” (the default), "Correct Answer”, or
"Alternate Answer”. Normally, when you are creating buttons to go to other cards, eic., the
setting is "No test function”, Buttons created this way are neutral, and have no effect on the
test status of a stack or card.

If you elect to make any button in a stack either "Correct Answer” or "Alternate Answer”, that
stack is now considered a "Test stack”. When a stack is quit, either by quitting HyperStudio,
launching another application, or branching to another stack, HyperStudio writes to a text file
on the disk, in the same directory as the stack, named HS.TestResults. The information
written includes the stack name, the time and date, a list of which butions were chosen on each
card in the stack, and a final "score” for thal stack. Information is wrillen o the
HS.Test.Results file on a cumulative hasis, so this one file contains the results of all stacks in
that directory that are used until the file HS.Test.Resulis is deleted. The HS.Test.Results file is
not writien o if there are no test function buttons in a given stack.
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The results for a given stack are calculated as follows:

When the stack is terminated, and the HS.Test Results file is written, HyperStudio scans the
entire stack to see what buttons were pressed as the stack was being used. For each card, it
writes out the card ID#, and which button on a card was the last one clicked on. If no button
mummrdwnscljckndun.mifﬂwbuumcljckadmma'Nor.&s:ﬁuttim'buum,mmnu
entry is writien for that card.

If the last button clicked on a given card was defined as either "Correct Answer” or "Alternate
Answer”, then HyperStudio will record the button name as the chosen button for that card. The
final score will be the number of "Correct Answer” buttons chosen {maximum one per card)
compared to the number of total cards with test function buttons on them.

There can be as many Correct Answer, Alternate Answer, or No Test Function buttons on a
given card as you want; only the last button clicked on is used in recording the resulis,

This actually is a fairly simple and straight-forward system, but you may want to experiment
with different kinds of stacks and button combinations o see what works best for you.
Different possible setups include:

* A simple multiple-choice test stack, where each card is one question. Each possible answer
button moves you to the next card. Correct Answer buttons are defined as appropriate;
Alternate answer buttons are used for the others.

* A variation on this is to include forward and backward arrow buttons on each card, defined
as No Test Function. Clicking these will not affect the "last button clicked" status on any
given card. That is, you could click on a choice (perhaps that responded with a voice
confirmation), and then click on the forward button. HyperStudio would still record the button
chosen, and would ignore the forward button,

* A timed test, where each screen also includes an aulo-activate button that moves to the next
card after 10, 20 or 30 seconds (or whatever). The user would have to choose one of the
possible answer buttons in the allotted time period. The final HS.Test.Results file would
record which button on each card had been chosen.

To use the test results, you should load the HS, Test.Results file into a word processor. It is also
possible to write simple Applesoft programs that will read the file, and organize the data, but
this is a custom application that depends on your own time and interests. You could also
specify the file HS.TestResults as the source of a text item in another stack, using the extended
data access method. :

The test functions can be used not only for the classic sort of tests, but also for user profiles as
well. Imagine a stack that begins with a picture of three bowls of ice cream, Each of the .
bowls is set up as an invisible button, each named "chocolate”, "vanilla”, and "strawberry”. At
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the end of the stack, the HS.Test.Results file will create a file that tells you which button they
selected. In this case the "Correct” or "Aliernate” answer aitribute for a bution doesn't matier
(although it must be one or the other). What you're getting is the information about which item
they chose on a screen. If 100 people were 10 use this card in a stack, then the HS.Test.Results
file would contain a survey of 100 people, and a study of the percentage of what flavor ice
cream was preferred.

Auto-Activate Buttons

Normally, a button has to be clicked on by the user 10 be activated. Suppose, however, that
you wanted a sound to play immediately when a card was displayed. How could you do this?

The answer is with auto-activate buttons. An auto-activated button "presses itself™ after a set
number of seconds after a card is displayed. The button can also be set to continuously cycle in
the time period se.. To set up an auto-activate button, just check the anto-activate box, and
enter a time (in seconds) after which the button should activate, If you want the button to
repeat its action, check the repeat box also.

Another use for Auto-activate buttons is o prompt the user if they don't elick on something on
the screen in a certain amount of time. This could be a help card, or it could also be used 1
create timed tests.

Auto-activate butions are not active (at least not self-umed) until you tum on the Auto-activate
function in the Preferences dialog box, and you are in the browse mode. This is so that you
don't have to worry about auto-activate buttons going off while you're trying to edit other parts
of a card. Auto-activate buttons are automatically turned off when you select a paint or editing
tool, and are not tumed back on until you select the browse tool and move o another card, or
turn on Aulo-activate in the Preferences menu.

Adding Other Objects, Continued...

Add a Graphic: This menu item is used to add a graphic object 1o the current card. When you
choose this, you will be presented with the File Interface for choosing the graphics file you
want io use. Once the graphic has been selected, and if this is the first graphic you have added
since starting up HyperStudio, you'll get a dialog box explaining that the next step is to size the
graphic 1o the size you want, and to position it on the card.

Remember when adding a graphic to a card that the graphic retains its own identity as an
object on the card. This is in contrast to just adding a portion of a graphic screen as clip ar.
This feature is best used when you have many cards with an identical background. If you are
just adding some graphics to a card, it is better 0 use the Add Clip-Art function in the File
menu.
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After you have chosen a file on the disk, a rectangle is displayed that shows a portion of the
graphic screen you selected. You now have 1o decide how much of the image you want
displayed on the card, and where you want the graphic located. By putting the mouse
anywhere inside the rectangle, holding the mouse button down, and then dragging the mouse,
you can move different parts of your graphic image into view. If you want to re-size the
rectangle, use the mouse to grab any of the handles on the sides or comers. Dragging any part
of the frame that is not a handle will move the entire rectangle 1o a new position. Remember
that the window "frame” is only shown so that you can size the window, and scroll the image
area. Once positioned on the card, the window frame is not shown unless you edit the graphic
again.

When the graphic has been positioned and sized, click anywhere outside of the box to indicate
you are done positioning the graphic. You'll then be shown a choice of borders that you can
use for the graphic. If your graphic is a picture that is very different from the background,
you'll probably want to use a border. On the other hand, if you want the graphic to look like it
is a part of the card, and presuming that the background in the graphic is the same color as the
background on the card, then you can use "No Border”.

Unless you have the Preferences option set to Advanced User, you're now done, and you can
go on to your next operation in HyperStudio. If you have set the Advanced User option, you'll
then be asked to set the data access method. See the section on the Advanced User option for a
detailed discussion of the choices.

Add a Text Item: If this is the first text item you have added since starting up HyperStudio,
you'll get a dialog box explaining that the next step is 1o size the text box to the size you want,
and to position it on the card. Successive text file selections proceed the same; they just aren't
preceded with this "help” box. After clicking on "continue”, a rectangle is displayed that shows
where the text rectangle will be placed on the screen. You can resize and reposition this
rectangle, just as you would an invisible button. Drag the center of the rectangle to reposition
it; drag the comers to resize.

When the text item has been positioned and sized, click anywhere outside of the rectangle to
indicate you are done positioning the rectangle. You'll then be shown a dialog box that gives
you the options of using scroll bars, a rectangle around the box, and whether the text item will
be changeable by the user or not. You can select any of these atiributes as needed.

You also need to decide if you want to use text from a file already on disk, or if you want to
enter text directly,

* Using a Disk Text File: If you choose to use a file from disk, you'll be presented with the
File Interface for choosing the ASCII text file or AppleWorks 2.1 word processor file you want
to use. The text file will then be loaded, and the text will appear in the rectangle.
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Remember when adding a text item 1o a card that, like the graphic item, it retains its own
identity as an object on the card.

Afier you have chosen a file on the disk, if you want to resize, reposition, or change the
attributes of the text box, you can use the text tool in the Tools menu, select the text item, and
then choose Item Info from the Objects menu.

Unless you have the Preferences option set to Advanced User, you're now done, and you can
g0 on 1o your next operation in HyperStudio. If you are using the Advanced User Options,
you'll be able to decide whether to imbed the text in the stack, or o use the extended (disk-
based) data type. See the section on the Advanced User option for a detailed discussion of the
choices.

» Entering Text Directly: Afier choosing "Add a Text Item" from the Objects menu, if you
then choose to enter the text, you'll go immediately to the text box on the screen, where you'll
be able 1o enter text directly. Text is entered in the Browse Mode, so you can go on to another
activity at any time. There is no particular action required o end entering text.

As with text items created from a disk file, you can always use Item Info in the Objects menu
Lo resize, reposition, or change the attributes of your text item, Text in the text objects is
always in the Shaston B typestyle. If you want to put text on a card in other sizes and styles,
such as for titles, etc., you can use the text paint tool (Tools menu).

Add a Video: In this menu item, the procedure is identical to that for adding a video sequence
10 a button. The only difference is that the video will be added to the card itself, and will be
played when the user first moves to that card. See the description of playing a video on a
button-press for additional details.

Colors Menu

This menu is used to set the current color for the paint tools. HyperStudio uses 16 standard
"dithered” colors in the 640 Super Hi-Res mode of the Apple [IGS, plus 16 additional pattern-
type colors, for a total of 32 usable colors. You can load pictures created with other paint
programs that have custom palettes, but you must use some care in using these graphics on a
card. The main problem is that the custom paletie may interfere with the appearance of the
menu bar, or other buttons or graphics on the screen. Full-screen backgrounds with no menu
bar, and invisible buttons, generally work best for custom-palette graphics.

You can also use the Add Clip-Art function to set the current card to a custom palette. Just
choose Add Clip-Art in the File menu, and load a graphic that has a palette you would like to
use. Now, clip a small part of the graphic, and paste it onto your current card background.
This will change the palettte on that card. If you want, you can then cut the bit of graphic back
out of your card if you don't want 1o use the image itself. The HS.Ar disk includes several
files, including Colors.Greys and Colors.Earth that can be used in this way to set the palette for
any given card using the Add Clip-Ant technique.
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Options Menu

'miliis used to control the operation of other functions in HyperStudio, in particular the paint
tools,

Line Size: This sets the width of the line 10 be used by the straight line, rectangle, rounded
rectangle, oval, and polygon tools. When you choose this item, you'll get a dialog box that
shows a number of different line sizes. Click on the one you want to select a given size.

Brush Shape: This chooses the brush shape 1o be used by the paint brush tool. When you
choose this item, you'll get a dialog box that shows the different brush shapes available. Click
on the one you want 1o select.

Draw Filled: Choosing this item places or removes a checkmark that indicates whether the
shapes drawn with the rectangle, rounded rectangle, oval, irregular region and polygon tools
will be filled with the current color or not. A checkmark indicates that these shapes will be
drawn as a solid shape.

Text Style: When either using the painting text tool, or editing a text object, this menu item
selects the current fon, size, and style of the text being used. The fonts available will depend
on what fonts you have in the Fonts folder on your startup disk. This does not have any effect
on the text in a text object. Text objects are always in Shaston 8.

Set Text Color: This is used to set the color used when you type text with the text tool in the
Tools menu. This does not have any effect on the text in a text object.

Set Background Color: This is used to set the background color used when you erase a
background, or use the eraser ool in the Tools menu.

Hide Items: Ordinarily, any particular card would have not only the background visible, but
also any g:*aptur:s. iext items, buttons, etc. This option lets you hide items, in case you want to
use the paint tools on the background without objects in the way.

Hide Menu: This is used to hide the menu bar on a given card. If the menu bar is hidden
when you move off a card by using a button, then the menu bar will also be hidden when the
user views that card. This allows you to create stacks without a menu bar. Press Apple-M to
restore the menu bar.
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Apple Menu

The Apple menu has an "About...” box that tells you the version number of HyperStudio.
However, the most important function in this menu is the Preferences choice.

Preferences

The preferences seitings are saved in each individual stack, and may vary between stacks. The
stack must be saved back io the disk after changing preferences if you want the changes to be
in effect the next time the stack is used. Preferences lets you control many aspects of a stack's
operation:

Password: This is to keep users from changing the preferences in a stack you have created.
The main thing protected by the password is access to the "Lock Stack” setting (see below). If
the password field is blank, then all the options are available when Preferences is chosen.
However, if you enter a password and exit the Preferences dialog, and then save the stack, this
password will be required the next time the Preferences dialog is opened. You'll also notice
that pressing Return is not required when entering the password. When the last letter of the
correct password is typed, the dialog box options will instantly become active.

Advanced User: This is used to tell HyperStudio that you would like more control over how
the data for objects on each card will be stored and accessed. Normally, HyperStudio embeds
the data for each object that you add right into the stack that you are creating, without asking

you how you want the data accessed. This is less confusing to a new user, and creates fast and
easily transportable stacks. However, if you have set the preference to Advanced User, you'll

then be given some options about how you want the data for objects 10 be accessed by Hyper-
Studio.

From then on (or until you change the Advanced User Option to "off”), whenever you add a
graphic, text object, or sound, at the end of the process you'll see a dialog box asking you to
"Select the Data Access Method for this Item:"

The two choices are "Embedded (In the stack)”, or "Disk Based”. Here's what these choices
refer to:

» Embedded Data: When you add a graphic, sound, or text item to a card, the default is to
actually store the data for that item within the stack itself. This is both convenient and gives
faster movement between cards in your stack. The other advantage of this method is that your
stack is very transportable. That is, since everything that makes up that stack is within the file
itself, moving the stack from disk to disk is as simple as copying a single file. This type of
object is also called an embedded data object.

However, suppose you wanted to create a stack that used literally hundreds of graphics, text,
and sound items, Even with megabytes of memory, you would soon want to have more data in
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your stack than could actually fit in the computer's memory all at once. It is also possible that
at some point in the future, you may want to access data, such as that on a compact disk or
laser videodisk, that cannor be physically imbedded in your stack.

* Disk Based Data: In all of these cases, HyperStudio provides an alternative way of access-
ing text, graphic, and sound items. The second choice, Disk Based access, gives you the option
of leaving the graphic (or other) file in its current location, and having HyperStudio go back to
that location whenever it needs the graphic. This is called an extended data object. Although
this gives a slower transition time between cards, it significantly increases the overall size of
the stack that you can create, and the data il can access.

The second advantage of the extended data type is that other users of the system can update the
data displayed on a card independently of HyperStudio. For example, you might have a draw-
ing on a card as a graphic item that showed the fire exits to new employees. If for some reason
the fire exits were changed, by updating a single document - the graphic picture - all stacks that
referenced that illustration would be automatically updated as well. This is a very powerful
concept, and works well in situtations where the computers are operating on a nefwork.

As an aside, this also makes the instant distribution of all kinds of information possible. This
could include memos to staff, names in an organizational chart, instructions to students, or
often-changing data like price guoles, etc.

The default in HyperStudio, when shipped, is to always use the embedded data system. This
means the user has less to worry about, and stacks are easy to move and operate. On the other
hand, as an advanced user, you may want to take advantage of the alternale data access
method.

Also, when Advanced User is set, you will not get the small instructional dialog boxes the first
time a button, text or graphic item is added.

Auto-activate buttons on: In the manual, auto-activate buttons are described as those buttons
that activate themselves after a set amount of time. While editing a stack, however, you may
not want the auto-activate buttons going off while you're trying 1o work on a card. By uming
off the check-mark in this option, auto-activate buttons will not be triggered unless you manu-
ally click on them. When you are ready to save your stack for the final user of your informa-
tion, set the check-mark in this box, and save your stack 1o the disk. Auto-activate buttons are
automatically turned off when you select a paint or editing tool, and are not turned back on
until you select the browse tool and move to another card, or turn on Auto-activate in the
Preferences menu.

Lock Stack: If you are designing stacks for use by others, and in particular, situations where
you don't want the user to be able to use the editing tools, you can select "Lock Stack” in the

Preferences menu (remember to save the stack after making the change). Unlocking the stack
restores the complete menu bar. Since the Lock Stack option is available via the Preferences
function, it is advisable to always sel a password if this option is going to be used.
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Show card number in menu bar: When this is enabled, you will see the number of the
current card displayed in the right side of the menu bar. This is useful whrmcmmng and
editing stacks, although you'll probably want to turn this off when the saving the stack for the
final user.

Erase background on mew card: When this is checked, HyperStudio erases the backgm_und
when "New Card" is chosen in the Edit menu. However, if you are using a background, like a
notd:mkpage.ﬂmmbeumdmmydiﬁ‘ermtcardsinamk,mmymwﬂlwmttomakc
sure this option is not checked (tumed off). Now, whcnyouchmseNEwCard.:l'_le'cmnt
background will automatically be used by the new card. Since there may be no visible sign a
new card has been created, you will probably want to have "Show card number in menu bar
tumed on.

Remember that when a background is duplicated for a new card, the background is actually
shared between two or more cards. This can have significant memory savings, but only if you
don't alter the background on duplicated cards with the paint tools. You can alter !M‘pnma_ry
card with the original background (with duplicated results!), but if you paint or otherwise edit
other cards, the background will become an original background on the edited card.

Use TouchWindow: This option lets you use HyperStudio with the TouchWindow from
Edmark Corp. This is a very useful add-on with HyperStudio, and lets you use your stacks
with very young children, and anyone who is new to computers. Touching the screen becomes
equivalent to clicking with the mouse with the TouchWindow, and makes for a very pleasant

compuler experience.

When you check this box, and then click on Ok in the dialog box, it is assumed that you have a
TouchWindow currently attached to your computer. At that point, a dialog box appears
explaining that the TouchWindow will need to be calibrated by touching each comer of the
active screen area (this does not include the monitor border area). Once activated, the
TouchWindow will stay active until you exit HyperStodio.

This function is not stack-specific, and when HyperStudio is run again, the TouchWindow will
have to be re-activated and calibrated. This does not have 1o be repeated for different stacks. If
the TouchWindow calibration is not correct the first time you do it, you can re-calibrate by
turning off the TouchWindow in the Preferences menu. Exit Prcfe.remeg. and then choose it
again and turn the TouchWindow back on. You'll then be able to re-calibrate the screen. When
calibrating, try to not drag your finger as you touch each comer. Remember, you're trying to
tell the TouchWindow where a specific point (the comer of the screen) is. Turning off the
TouchWindow once it has been started up may interefere with keyboard commands. Keyboard
commands will be properly recognized once you leave HyperStudio, or re-activate the
TouchWindow.

Volume Control: This slider lets you control the overall volume level of the stack in memory.
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If you get a stack that plays sounds using the built-in speaker, for example, the sounds will be
too loud if you are using an external speaker. Likewise, if you have a stack that was set up
using an external speaker, it may be too quiet using the built-in speaker on the GS.

The volume in HyperStudio is controlled by a combination of factors. The Control Panel
volume is factored into the overall sound volume in all HyperStudio stacks - this is the system
volume. If you want to change the overall playback volume in a stack, use the slide control in
the Preferences section - this is the stack volume. If you want the new volume to be perma-
nent, remember o save the stack back to disk. The volume of a particular sound is selected in
the tape deck screen when a sound is first added.

More About Data Access Methods

Local Data: There is also a third access method that is a variation of the extended data type.
However, this method is dependent on how you store your files on disk, rather than a specific
choice in HyperStudio.

When HyperStudio tries to locate the file for disk-based data, it first looks in the same direc-
tory as the stack, regardless of what the absolute location of the data was when it was linked to
the stack. Data located in the same folder as a stack is called local data.

The main advantage to putting all the disk-based data in the same folder as your stack is
transportability. Suppose you had created stacks on your own hard disk that referenced text,
graphic and sound files in various locations on your hard disk. If you then wanted to move the
stack onto a 3.5" disk, the only way to run the stack would be to have the hard disk attached to
the same computer that the stack was running on.

With a standard extended data item, the entire data remains in a disk location which must be
available when the stack is used. When it comes time to move the stack from one disk 1o
another, it is unlikely that you will be able to easily move all of the data files referenced by a
given stack, especially if the data is located on many different disks.

By keeping all the data files referenced by a given stack in the same folder, moving the stack is
as simple as moving the entire folder from one disk to another using any file copying utility
such as the Finder, DeskTop, Copy I+, ProSel's Cat Doctor, etc.

In general, when designing a stack, you can use the following guidelines:

* When the entire stack can fit in memory all at once, use the imbedded data type. Stacks
done in this manner are also much easier to distribute to others.

» If the stack will be running in a stable environment, where the referenced data does not
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change in its location, and you want to have common files that are accessed by a variety of
different stacks, then the extended data type is recommended.

« If you are using disk-based data because of memory considerations, and you anticipate
moving your stack to another disk, then move the referenced files to the same folder as the
stack.

File Location Dialog Boxes

When HyperStudio cannot locate the volume that a data file is located on, it will first display a
dialog box asking you to insert the needed disk. If you cancel this dialog box, then you'll get a
dialog box asking you to manually locate the file on any disk or folder. If you cancel this
dialog box, then HyperStudio will skip that data item in building the card, or executing a
bution action, and will continue as well as possible.

Last-used directories

When adding clip-art, sound files, loading stacks, etc., HyperStudio remembers the last-used
directory for various kinds of data. This makes it easy to go back to the last directory you
loaded something from. However, you should also remember that if you put artwork, sounds,
eic. in other directories, the first time you go to add clip-art, you will have to use the Standard
File interface to open the necessary folder. If you have a large number of HyperStudio-related
files, you may find that organizing subdirectories is both useful and necessary.

Alternate Home Cards

The Home.Stack on the HyperStudio disk has been set up with the beginning user in mind.
The Home Card in this stack shows the stacks available on the different disks in the HyperStu-
dio package, and also inviles you to a special screen (the Just Starting... icon) if you are new to
HyperStudio. From this second screen, you can see what different areas of interest have been
addressed by various stacks.

However, once you've used HyperStudio for a while, you may wish a more direct Home Card,
without the Just.Starting... icon. On the HS.Demo disk, you'll find an alternate Home Stack
that may be more efficient for daily use of HyperStudio. Also, remember that the Home Card
is just a graphic image with invisible buttons. You can use the paint tools to create your own
unique Home Card, such as a picture of a desk with items on it, the bridge of a starship, or any
other interface that makes it easier for you or the person using HyperStudio.

HyperStudio Sound Shop

The Sound Shop™

The Sound Shop utility is designed to let you digitize, edit, and save sound files for use with
the HyperStudio system. Although HyperStudio lets you record a sound while you are creating
a siack, the Sound Shop is provided to give you more control over all the aspects of the
recorded sound. It can also be used for converting sound files from other sources, such as
public domain sound sample disks, and sounds recorded with the MDIdeas, FutureSound, or
Applied Engineering products.

To run the Sound Shop, click on the Sound Shop icon in the HyperStudio Home Card. Sound
Shop can also be launched, like any GSOS system file, from the Finder, Program Launcher, or
other program selector,

Using Sound Shop is very easy, and the best place to start is with recording a sound using the
microphone, and then seeing what you can do with it!

The first thing to notice on the Sound Shop is the overall screen layout. The blank window in
d?ewphslfoflhcscrwnismremcsuundwavefm‘whamw:rsumdyoumom'dorhad&um
disk will be displayed. The window is blank now because there is not a sound in memory yet.

Below the wave display window are three boxes that show important number values about how
much memory you have available for recorded sounds, how much time that represents at the
current record and playback rates, and other useful values,

The scroll-bar controls at the bottom of the screen are used to control the recording and play-
back of sounds in terms of volume, record/playback rates, an “"echo" special effect, a repeat
count, and the start-recording threshold value.

To the right of the status boxes are three yellow buttons. "Record" starts the recording process.
"?Iay" starts the playback, and "Stop" is used to stop the playback. Above these buttons is an
"input level” indicator, and is used to check the current "level” of the sound input device, such
as the microphone, tape input, etc. The Play and Stop buttons are disabled because there is no
sound to be played yet.

A Brief Test of the System

Bﬁnrc starting, you should have already installed the HyperStudio sound recording card
(digitizer) and microphone according to the installation instructions at the beginning of this
manual. If you have not already done so, go back and install these devices now.

an‘ microphone should be plugged into the back of the computer. If the microphone is
functioning properly, you'll see a green vertical bar just above the Record button. This is the
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level indicator, and is used to make sure that a sound input device is both connected, and, if
necessary, set to a sufficient volume for a good recording. The green bar should move up and
down as you speak into the microphone. If the microphone is not attached, the bar will be red.
The bar also turns red whenever the input signal is too strong for a good recording, such as
when you shout into the microphone, or if the volume were tumed up too high on a tape player
attached to the digitizer card. The bar should not be red under normal conditions if the micro-
phone is attached, and there is no excessive sound input.

You are now ready to record something. Before you record, check the Record Rate and
Playback Rate controls at the bottom of the screen. For now, both these values should be
10435. The rate value tells you how much memory is required for each second of sound
recorded. In this case, you will use 10.4K of RAM memory per second. This is a good rate for
recording a voice. We'll look at this in more detail later, but for now, the important thing to do
is to make sure the values are the same for both record and playback.

The other settings should be at their default values:

Echo Delay: off
Record Threshold off
Play Volume 6

Repeat Count off

To record your voice, click on the Record button with the mouse. When you see the screen
border turn red, count into the microphone: "One, two, three, four” (and pause just a little
between each number!). The level indicator will not be active during a recording. It is only
used 10 check the level prior 1o recording. Press the Return (or any other) key 1o stop the
recording. (Stop is only vsed for stopping the Playback function),

Note: When recording your voice using the microphone, you will have to speak "firmly” for a
good recording, but an overly loud, or shouting voice is not required. Holding the microphone
close to your mouth will help. The right level is sometimes called a "radio voice”, that is, the
way a radio announcer would speak into his microphone for best clarity and volume. This
works for them, and it will work for you!

The default value of 6 for the playback volume has been set up for best results when using an
amplified speaker like the optional HyperStudio powered speaker. If you are using the
internal speaker, adjust the volume control to a value of 10.
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After a brief pause, the wave display window will be redrawn to look something like this:

ok File Edit Teols Sound  Settings
Curreat file nawe [5: 0NE.2.3Y

" cr T
WEWDRY STATUS BUFFER SWTUS D ITOR STHTUS
Totel memory 1197664 | Somple sive: W1TH $i: 0
Wozinum time:  179sec. | Record time:  $dnec. | Stort: 30201
Rwailable: 1255436 Plogtime:  Nuee End: @
Clipboerd: empt Clip time: empty [Lewvel: 0

T

The data you have just collected is sometimes called a sound sample, and is a digital recording
Pf your voice. At the current rate seiting (10435), the computer is checking the microphone
input abou_t rqmo times each second, and recording a number value for each moment. When
merw:rdmg:smmplcwd.lhedamwiubegnpmdonltuscm.mamnﬂﬁnggnphm-
sents the sound sample. Each grouping in the sound wave is one of the words you spoke. The
computer plays back your sound sample by re-scanning the data, and sending the recorded
signal back out to the speaker,

To hear your recording, click on the Play button, and listen to the sample. Play it several times.
Try;p'css;pguwSmphuumhﬂmmiddleofuwplaybact.Nowlet‘splonemhnhheomu
funcutmsmtheS{umdShop.mdsecwhukindsufﬂllngsSnmdSthwi]lletymduwirh
your recording.

Playback Rate: Use the mouse to change the Playback Rate (the slidebar control near the
bom)mofﬂmscrecn].‘l’ryvalumufaboutm,fll}ands,ﬂm.lfdmﬁaybmkﬂmisﬁ.nu(a
value larger) than the Record Rate, the pitch will be higher, and the sound sped up; if the
Playback Rate is slower, the pitch will be lower, and the sound slowed down. When you save
the sound sample 1o disk, the playback rate setting will be saved with the file.

Playing Part of a Sample: Set the Playback Rate back to 10435. Now move the mouse
pointer until it is in the sound wave window, and positioned at the beginning of the third sound
wave group. Press the mouse button and hold it down, and drag the mouse until the entire wave
group is highlighted. Then release the mouse button.
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WUFFER STATUS ERITOR STATUS |4

Total memory 1297664 | Songle slze: WAT2E Sizer 7090
ting:  IMisec | Recordtime:  §3uee. | Stort: 29610
Rveilable: 1253938 Floytime:  Wsee, | End 1010
Cliphbord:  ematy Clip time:  emph Level: -1

Record Kote mii “iiﬁlm 10033 Eeunnﬂ i"
'Il:ﬁ‘l'hrllihnll off Plul'll1.= i Iliuiilul aff

This is how you select part of the waveform in Sound Shop. Now press the Play button. Notice
that only the waord "three” is played. Whenever you select a portion of a sound, Sound Shop
plays only the part selected.

Volume: This controls the playback volume of your sound sample. It does not affect the
recording volume. Like the Playback Rate, the Volume setting will be saved when your sample
is saved to the disk. This is so that you don't have to adjust this control within a StudioWare
application if you don't want to. Try changing the volume now to see how it affects the sound.
Because of the way in which sound is done on your computer, very high or low volume
settings will not sound as good as the moderate settings.

Repeat Count: This controls how many times the sound will be repeated when it plays. This
might be used, for example, with sound effects like a gunshot or footstep. When the sound is
repeated a few times, you can get interesting effects without taking up the large amount of
memory that a larger sample would require. Try changing the Repeat Count to 3, and press
Play. You should hear the word "three" said three times.

Echo Delay: This controls a delay within the computer between the repeated playing of the
sample. Each repeated action, however, is started while the previous playback is still playing.
The result of any given value depends on a combination of the sample length, the Playback
rate, and the Echo Delay value. Even slight variations in the Echo Delay value can produce
different effects. In general, the echo effect will vary between a "close” echo, reminiscent of
singing in the shower, and a "larger” echo, like that of a stadiom.

The best approach is to start with an Echo Delay value of, for example, "40", and then play the
sound sample. Then adjust the Echo Delay 1o 39 or 41, and try again. Experiment until you
get just the effect you want.

Remember to set the Echo Delay back to "off" before trying the functions described mext. It
doesn't hurt anything to combine it with other functions, but there will be less confusion if you
leave it "off” for now.
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Record Threshold: Ordinarily, recording staris soon after you press the Record button.
However, suppose you want to start the recording process only when the sound actually starts.
The Record Threshold lets you specify a number value that represents how loud the sound
should be to trigger the start of the recording process.

To see how it works, first do a recording with the Record Threshold set to "off". This means
recording starts as spon as you press the Record bution. Before recording, click the mouse in
the wave display window once 10 deselect "three”, if necessary. Then, press the Record button,
wait for a few seconds, and then say "one, two, three". Then press the Return key to stop the
recording. Your recording should look something like this:

ok File Edit Tools Sownd  Sevtis

KEHORY STATUS BUFFER STRTUS

Total memary: 1207664 | Somple size: WhEVE Sire HO1y S

Hoximum time:  124sec, | Record time:  $3sec. |Stert: 7172 |8
Rvailoble: 1730816 Flogtime: Wsee | End 36186 s
Clipbosrd: empty Clip time: emgty  |Level: -2 Chiadebact

IIEI‘ Hii “E 4 ck Rate 10435 [:hnhla ¥y

Record Threshald  off P]='H|I-| I Iﬂi i=i aft
[ e R R T ]

Thc‘relativc!y flat area at the beginning of the waveform is the time you were pausing before
starting to count. This wait wastes memory. If the sound you want to record is not predictable,
you could use up all the available memory just recording the waiting period.

Now set the Record Threshold to 10, and press Record again, This time the screen border will
turn to green. Wait a few seconds once more, and then count "one, two, three” and press
Retumn to stop the recording. As soon as you started speaking, the screen border should have
changed to red, indicating that the recording process had begun.
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This time the recording will look like this:

ok File Edit Toals Sewsd  Setti
Current file pone is: BNTITLED

WEHORY STATUS BUFFER STATUS ERITOR STATUS M
Total memoryc 1297664 | Songle vize: 23836 Size: IOFIN (o
Waxinem tine:  17sec. | Record tine: stort: 7172 (Ml

fveiloble 1271808 | Flew Lime: Ind 36186 ;
Clipboord: empty Clip time: empty  [Level: -2

I“"Ih“ 19435 Plewbock Rote 10415  Eche DlI= kL)
laiimtihﬂ “ “ﬂ h‘iiﬂ l IHIII Lount off

This time there is no wasted space at the beginning of the recording. The number value you
choose depends on the sound you are recording. The center line of the waveform window has a
value of zero. The very top and bottom of the window represent values of +127 and -127,
respectively, If the sound you are recording has large peaks (i.c., is relatively loud), you can
use a high threshold value, for example 50-100. On the other hand, if you're trying to capture a
quieter sound, a smaller value like 5-10 would be better.

Now let's look at some of the menu functions in Sound Shop.

File Menu

This menu is used to save sounds you've recorded with Sound Shop onto a diskette, and to
load the sounds back into the Sound Shop or HyperStudio. Use the mouse to pull down the
File menu and examine the entries. For many of the menu commands, there is a keyboard
equivalent. That is, you can press a key instead of using the mouse and menu. For example,
pressing N gives the same result as choosing New from the File menu.

New: [(JN] This erases whatever sound is currently in memory.

Open: [30] This loads a sound file from disk. When first chosen, Sound Shop shows the
files in the same directory as where the Sound Shop software was located when it was run. On
the HyperStudio disk, this will be the pathname /Hyperstudio. There is another disk in the
HyperStudio package, called HS.Sounds, that has a sampling of digitized sounds. Try loading
a sound file from this disk.
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To load a sound file, select the file you wish to load, or Cancel to go back to the main screen.
ChclungonDmkchmguﬂwditbeingemhwiﬂicﬁngm%chmﬂmfolﬂu(ﬁmy}
dmmmcmmyin.mdrcunmyoumapmvims"levul"inthcd.iakcﬁ:mcm.

Note:Hyuuhgverq:mﬂcdamad,arlmda:lamndﬁleanﬂthmnﬂﬂeachungcl.oit.using
meomﬁmmpnmnﬁmbﬁngupadialogbuxmalmindsywu:ecmmﬁ]chumbecn
saved. If you click on "Yes" (lo save the file), you'll be shown the current disk directory, where
_mucanmtgnhcnametnsavctbeﬁlemdw.Aﬁuuvingﬁcﬁlc.ym‘]]bcimmdimety
prescnwdmmrhedlskdi:u:magainmyoumunpenlheﬁlcyunwam]fymchmsc"hio"
(not to save the file), then the sound file you load will completely replace whatever sound file
is currently on the screen.

Save: [(3S] This function is used to quickly save a file under the name that it currently has.
You cannot use this function until you have done a Save As (thus giving a new recording a
name), or unless you have loaded an existing sound file from disk (in which case it already has
a name). Once the filename is known, this menu item will read something like "Save File-

name -,

Save As: Thisisus:edmsaveaﬁlemamwme.mﬂisrequjmdbsaveanewmumding
where a new name is required. As with the Open command, you'll be shown the current disk
directory, and asked for the name that will be used when saving the file.

Revert: This is used to re-load a sound file on the disk, without having to through the more
lengﬂmyOpcnmum.ﬁremph.fmhaveloﬁedamﬂﬂegwﬁsk,m:mw
changes, and then decide to start again with the original file, just choose Revert (which will
acum]]_ymadsunnuﬁngﬂkckcvenm'ﬁknm“). This loads the original file, completely
replacing whatever sound file is currently on the screen.

Quit: [3Q] Choose this when you want to quit Sound Shop, and return 1o your program
splecr.m'. If you have not saved the sound sample currently on the screen {urymac!e changes
since the last change), you'll be given an opportunity to save the file before you quit.

Edit Menu

This menu contains the cut, copy and paste functions, and other useful commands related to
editing your sound sample.

Undo: [(3Z] This is used when you want to change your mind about some editing action you
have taken. Not all actions can be undone, but many can. If you cut a portion out of a sample,
-::h:onmng Undo puts it back. If you paste some data into your sound sample, and change your
mind, Undo removes what was just pasted, and leaves the clipboard with the data still on it. If
you are new to the idea of the clipboard, and copying and pasting data, the next sections will
explain this in greater detail.
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Cut, Copy and Paste: [3X, GC, & (V] These three functions are used together to either
remove part of a sample and move it 10 a new position in a sample, or to copy a portion of the
sound from one position in the sample to another. There are also special effects that can be
done by combining these editing functions with some of the Tools functions described a little
later.

Selecting Cut from the Edit menu removes part of your sound sample, and puis it on the
computer's clipboard. The term "clipboard” is used to suggest how the editing process works.
Using the mouse, you first select a part of the sample on the screen. For example, record the
words "one, two, three, four” as you did earlier. Now use the mouse to highlight the third wave
group on the screen, which corresponds to the word "three”. You can check this by pressing on
the Play button after selecting the desired part of the waveform. You should hear just the word
"three".

Now use the mouse to pull down the Edit menu, and choose Cut. After a brief pause, the
screen will be redrawn, now with just three wave groups. Click on the Play button. You should
hear your words "one, two, four”. "Three" has been cut from the sample. To hear what is on
the clipboard, choose Play Clipboard, which is near the bottom of the Edit menu. You should
hear just the word "three".

Now, for fun, position the mouse between the first and second wave groups, and click once. A
marker bar should appear. This is used to indicate where you want data from the clipboard o
be placed. We can now insert the word "three” in the sample by using the Paste function.

Choose Paste now from the Edit menu. Again, there will be a brief pause while the sound on
the clipboard is pasted into the sound sample at the marker bar. When the waveform is re-
drawn, you'll again see four sound groups. Press the Play button to hear the edited sample.
Now it should count "one, three, two, four”.

The Copy function puts a copy of the selected sound portion on the clipboard, but does not
remove it from the original sample. This is most useful when you want to use the Layer
function in Tools menu. See the Layer command for a description of its use. You can also use
the Copy command to get part of the sound from one file, then load a second file, and paste the
sound portion into the second file.

Important!! If you are copying and pasting between two separate files, and the playback
rates in each file are different, you will get accordingly strange results.

There is really no way to get around this problem, other than adopting the habit of trying to
minimize the number of different recording rates you use when you create your sound
samples. Although the Sound Shop provides a very wide variety of record and playback rates,
this is mostly in the interest of compatibility with sound files created with other hardware
products. From a practical standpoint, the 10435 recording rate will perform just fine for most
voice recordings, and for music, or sounds with a lot of high frequencies, a rate of 16398, or
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perhaps 22824, will work well. If you limit yourself to using just these rates, you'll have much
more flexibility in combining parts of one sample with another.

Clear: The Clear function is a lot like a Cut, except that the clipboard memory is not used. For
example, suppose you had the word “three" on the clipboard, but wanted to completely delete
the word "two" from the middle of the sample without losing the word "three". By selecting the
sound for "two" and choosing Clear, the selected portion would be removed from the wave-
form, and the sound "three" would still be on the clipboard. Try it now to see how Clear works.
Clear the word "two" from your sample, and then choose Play Clipboard 1o verify that the

word "three" is still there.

Play Clipboard: This plays whatever is on the clipboard from the last Cut or Copy operation.
This is useful to hear exactly what you have captured on the clipboard before pasting it
somewhere else in the current sample, or even another sound file.

Clear Clipboard: This erases whatever is currently on the clipboard. The main use for this
would be in those cases where you wanted to absolutely maximize the amount of me

available for a subsequent operation, such as a long recording. This is most likely to only be of
use when the Maximum Memory option is in effect (see the Settings menu description later).

Tools

The Tools menu provides a number of additional editing functions that can produce interesting
effects, and help you create the best sample possible. In general, if no specific part of the
waveform is selected, then the action will be performed on the entire sample. On the other
hand, if you select just part of your sound sample, then only the selected part will be affected.
Let's see what each of these functions is used for.

Erase: [BE] This clears the selected part of the waveform back 1o zero (the center line). This
is used most often to erase just part of a sample. To see how this works, we'll record something
with a deliberate flaw, and then use the Erase command to remove it. First record the words
'Gflﬁ. two, three, four” again. However, this time, between the words "two" and "three”, tap the
microphone once with your fingertips.

When you play the recorded sound, you should hear our rather contrived "pop” between the
words "two" and "three”. You can see this in the waveform as a sharp spike in the middle of
the recording. Use the mouse to select just the spike. Verify you have our deliberate error in
the recording by using the Play button. Now choose the Erase function from the menu. The
selected part of the waveform will be erased back 10 the centerline, with the result that the
"pop” has been removed. This can be used when recording sounds from noisy sources, or in
those cases where you wanlt 1o remove just a portion of a series of sounds, but don't want to
change the length of the sample by using the Cut or Clear functions.
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Fade Up & Down: [BU & GD] Use this to taper the volume of a sound sample at the
beginning and end. Fade up starts the volume at zero, and ramps up to full volume over the
range you have selected. This would be used to edit a sample that had been "sliced”, for
example, from the middle of a longer sound. By doing a Fade Up at the beginning, your
sample will sound more natural. Fade Down is just the opposite, and is used at the end of a
sample 1o fade out the sound. These effects can be used anywhere in a sample, not just at the
beginning and end.

Filter: [(3F] This is a subtle "smoothing” function that can take some of the background
“hiss” out of a noisy sample. To use it, you select the portion of the sound sample you want to
clean up, and then choose Filter. If nothing is selected, then the entire sample is filtered. You
may have 1o use the function several times o produce a very noticeable effect. On the other
hand, repeating the operation very many times will start to make the part of the sound you're
interested in sound "dull” or muffled. This function is unlikely to be needed on any recording
you do with the HyperStudio hardware, but is provided to help you with sound files you get
from other sources.

Layer: [3L] This is a very useful editing tool. It takes whaiever is on the clipboard, and adds
it 0 the existing sound at the selected point. With it, you can produce your own "echo” effect,
and also mix different sounds, With the Layer wol, you can take what is on the clipboard, and
mix it with the sound currently on the screen, starting at the comrent edit marker,

For example, you might have one recorded sound of falling rain, and ancther of thunder, and
want to combine them into one sound sample. You would first load your file of thunder, and
copy a section you like using the Copy function. Remember, you can use the mouse 10 select a
range, and then use Play to make sure it's what you wanL

Once the thunder sound was on the clipboard, you would open your Rain sample file. What
you want to do is to add the thunder "in the background”, so to speak. Put a marker bar about
halfway in the Rain sample (by positioning, then clicking the mouse), and then choose Layer
from the Tools menu. The sound on the clipboard will then be combined with the rain sample,
starting at your marker point. Layer literally adds the two waveforms together, producing the
mixed sound that you want.

You can also use Layer 1o manually produce an echo effect. First, make a fresh recording now
of the familiar "one, two, three, four” test pattern. You can record it right over whatever might
already be in memory (if anything). Recording always compleiely erases whatever was in
memory.

Now, select the word "three" from the waveform, and also, look at the Editor Status box just to
the left of the Record button, and note where your selection starts. Choose Copy to copy the
word "three” 1o the clipboard. Now click once with the mouse slightly o the right of the
beginning of where you selected the word "three” a moment ago. For example, if your selec-
tion started at 21000, try putting the marker bar at 22000 before you choose Layer. The result-
ing effect should be a kind of "hollow" sounding echo. Now put the marker bar halfway
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through the word "three”, and choose Layer again. This time the resulting sound should be a
more "classic” echo.

Layering will also work better with higher record/playback rates. At lower rates, you may have
problems with the combined sound actually being quieter than the original files. Higher sample
rates avoid this problem, though obviously at the cost of a greater use of memory. Our advice
is to try o get the effect you want at a lower rate first, and then increase the rate only if neces-
sary.

Important!! If you are layering a sound that was copied from a different file, you will get
strange results if the playback rates in each file are different. See the discussion in Copy
& Paste for more information on this.

Redraw: [CJW - "Waveform"] This is used to redraw either a selected portion of the wave-
form, or to restore the original view after viewing just a portion. To see how this works, select
just the word "one" on the screen, and then select Redraw.,

Now press the Play button. Notice that just the word "one" plays, and that the screen is now
blue. With the Redraw command, you have "zoomed in" on just the part of the waveform that
plays the word "one”. Now select just the first half of the waveform for one. (Highlighting will
now be & light-colored region). Choose Redraw again, and then Play.

You should now have just the "wa" sound in "one”. With Redraw, you can select, and reselect
smaller portions of the waveform as many times as you wish until the window shows each
individual "bump" in the wave that creates your sound. Of course, very small samples will
reach the point where an audible sound may not even be heard, since you are dealing with a
sample that may be as small as a few hundredths of a second. The smallest sample that Redraw
will show is 256 data points from one side of the waveform window 1o the other.

To restore the original waveform display, just choose Redraw without selecting a region.
Choose Redraw now to restore the display.

Reverse: [CB - "Backwards"] This function reverses the selected portion of the waveform, or
the entire sample if nothing is selected. It is mostly of novelty value, although if your favorite
local radio station is having a contest to recognize popular songs played backwards, it may
represent some real income potential to you!

Stutter: [T - "Tripping off the tongue” Oh, all right, then you think of a better way to
remember it!] This is commonly called the "Max Headroom Effect”, since becoming popular-
ized by that once-famous television personality (yes, fame is fleeting!), It has the effect of
doing copy and then multiple paste of the selected sample. Try it on the beginning the word
"two". You want 1o select just the "t" sound of the word "two". Remember, you can choose
Play while a portion is selected 1o see if you have just the part you wanL

Once you've selected the part you want, choose Stutter from the Tools menu. Now click on the
Play button to hear the effect
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Sound Menu

This menu gives you the equivalent of the Play and Record butions, and also offers an aliema-
tive Record mode which can be useful in some situations.

Stop and Play: [H - "Halt" & (OP] These are equivalent to the screen butions. The impor-
tant thing to notice here is that there are keyboard equivalents of the Play and Stop buttons,
namely Apple-P and Apple-H. If you're doing a lot of repeated operations, it can more conven-
ient 1o use the keyboard, rather than the mouse, 10 operate the record and playback functions.

It is also important to notice, although it has been mentioned earlier, that the Play bution only
plays the selected part of the waveform. This is very useful when you are about to do a copy or
a paste, because you can make sure you have selected just the portion you want. In addition,
there will be times when you want to concentrate on just a portion of a recording, and this
makes it possible, without having to listen to the whole thing each time.

Record Modes: [CGR & (OM - "Mode"] Like Play, Stop, and other Sound Shop commands,
the Record function also has a keyboard equivalent, Apple-R. However, the actual way in
which the recording is done can be one of two different methods. In the usual, or defaulr mode
(Record Mode 1), the recording starts as soon as you press the Record button. The recording
stops when you either a) press the Return (or any other) key, or b) when the recording has used
up all available memory.

For short sounds, this works preuty well. If you are recording a sound off a sound effects tape,
for example, there is most likely going to be a space at the beginning where you start the
player going, and probably a bit of a space at the end where you let the tape play for a while
before pressing the Stop button in Sound Shop. However, both "dead areas” in your recording
are easily edited out by using the Cut or Clear editing functions.

But what about those cases where there are a lot of continuous sounds, (perhaps part of a cat
fight outside your window) and you want o get just the right part of the sample. When you
start the record process, it will stop on its own in a relatively short time, and you could miss
your perfect yowl just as you were restarting the recording for the fourth time.

Record Mode 2 is the solution to just this problem. Record Mode 2 is a continuous recording
operation that never stops until you press the Return (or any other) key. When you do stop the
recording, the last sounds you heard will be at the end of your sample, and you'll have how-
ever many seconds before that as are indicated in the Buffer Stas window. Al that point, you
will probably want to Cut or Clear most of the sound at the beginning of the sample to get just
the part you want as the file to save.

To tell Sound Shop you want to use Record Mode 2, just select Record Mode in the Sound
Menu. You'll be presented with a dialog box that lets you choose between the two recording
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modes. The current recording mode is indicated by which Record Mode is highlighted in the
gﬂum:l Menu, and will remain in effect until you either change the mode, or you quit the Sound
op.

Selected Record: Although not a specific menu item, this function can come in very handy. If
you select just a portion of your sample, and then choose Record, Sound Shop will replace just
the selected part with the new recorded sample. You can use this to "patch” a sound sample if
you wish. Note that this simply replaces the selected portion, and does not lengthen or shorten
the selected area. This means that if you patch-record a shorter sample than the selected area,
any area not recorded over will retain whatever sound was there. On the other hand, if you
leave the record mode on for a period longer than the selected area, the record mode will
automatically stop and you will not record anything afier that point.

Although the selected record function can be handy in some situations, the alternative method
is 10 use the copy and paste editing functions with sounds recorded in their own files, and to
merge the sounds at your leisure.

Important: Noie that Recording a new sound will always clear the clipboard,

Settings Menu

;I‘l‘ﬁs menu allows you to set and reset various Sound Shop parameters. The options are as
Ollows:

Current File: Use this to restore the sample size and Playback Rates to their original values.

Startup Defaults: Choosing this sets the sample length to approximately 2/3 of the total free
memory in the sysiem, and restores the Record & Playback Rates to the startup values.

Maximum Memory: To allow working room for the Clipboard, the Sound Shop normally
only allows you to use about 2/3 of the available memory to record a sound. If, for some
reason, you require the maximum amount of memory 1o record a sound, or edit a large file,
choosing this function will set the available memory to the maximum size.

Disable/Enable Cautions: Usually the Sound Shop tries to remind you about the conse-
quences of such actions as a layer or clear operation where the action cannot be undone.
However, if you would rather take things in your own hands, and not have to bother with the
occasional reminder messages, choosing Disable Cautions will temporarily disable this func-
tion. You will still be prompted when loading a new file, with a reminder if you have not saved
an altered file, or you've made a new recording.

Choosing Enable Cautions (alternate menu item in this position) will restore the normal
operation of the reminder messages.

Page 69




